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Overview
Crypto for Windows 95/NT is a small, easy to use, file encryption utility. Simply drag and drop files to quickly protect your 
sensitive documents, and then enter an encryption key to encode and decode the files you want to protect from prying eyes.

Drag and Drop Files
Files can be quickly selected for encryption and decoding by simply dragging them to the desired file list windows.

Purchasing
Crypto for Windows 95/NT is a fully functioning program. It is not time-limited or crippled in any way.

Crypto    for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use Crypto for Windows 95/NT you are required to register it. If after evaluating Crypto for 30 days you decide not to 
register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

Desktop Locations
Crypto’s location on the desktop is saved when the program is exited. Whenever you start Crypto it will reappear on the desktop 
where you last placed it. Crypto property sheet locations are also stored and reused the next time they are opened.

Taskbar Tray
Crypto for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing Crypto
Installation
To install Crypto for Windows 95/NT on your computer simply create a new, empty folder and place the files; CRYPTO.EXE, 
CRYPTO.HLP and CRYPTO.CNT there.

CRYPTO.EXE - The Crypto Application
CRYPTO.HLP - The Windows 95/NT Help File
CRYPTO.CNT - The Help Contents File

If you installed Crypto for Windows 95/NT using the SETUP.EXE program and selected the default installation setting Crypto for 
Windows 95/NT will be installed in the C:\Program Files\Software by Design folder.

To integrate Crypto for Windows 95/NT with the MS Windows Explorer select the Help | Setup menu item to open the Crypto 
Explorer Setup property sheet while Crypto is running.

Note If you have an earlier version of Crypto for Windows 95/NT installed on your computer, simply replace the CRYPTO.EXE 
and CRYPTO.HLP files with the newer versions. Crypto stores configuration information in the MS Windows 95/NT System 
Registry.

Note The CRYPTO.INI file is no longer used and can be deleted. The various application settings specified in the Crypto Options
property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT System 
Registry.

Note Some earlier versions of Crypto for Windows 95/NT included a CRYPTO.WRI documentation file. This file has been 
replaced by the CRYPTO.HLP file and can now be deleted.

Warning If you rename the CRYPTO.EXE file you must also rename the HLP file using the same basename. For example if you
change the Crypto application file name to NewName.exe, rename the help file to NewName.hlp. The HLP file must reside in the
same folder as the Crypto application file itself.



Configuring Crypto
Crypto Options
Select the File | Options menu item to display the Crypto Options property sheet. This window will allow you to change the 
various Crypto program settings listed below.

Place Icon in the Taskbar Tray
Check this item to display a small Crypto program icon in the Taskbar Icon Notification Tray. If this item is selected and the 
Crypto window is minimized a button will not be added to the Taskbar, to restore the Crypto window on the desktop press the 
small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running programs.

Note When this option is selected, clicking on the Close box in the upper-right hand corner of the window title bar will 
minimize Crypto instead of closing the application. To quit Crypto use the File | Exit menu command or the Ctrl+Q keyboard 
shortcut.

Minimize Program Icon at Startup
Check this item to minimize the main window on the Taskbar or Icon tray when Crypto for Windows 95/NT is first started.

Confirm Program Exit
Check this item to confirm quitting Crypto for Windows 95/NT. When this option is selected you will be prompted to confirm 
your intention to exit Crypto and return to the MS Explorer desktop. This item is useful if you run Crypto from the tray and wish
to avoid accidental exits when you right-click on the Crypto tray icon.

Remove the Original File After Conversion
Check this item to remove the original file after the conversion operation completes successfully. If this item is not checked the
original file will remain after encrypting or decoding operations are completed.

Use NSA File Erasure Method
Check this item to thoroughly erase the original unencrypted version of the files you encrypt. If this item is not checked the 
original file will simply be rewritten with all blanks and then erased. If this option is selected after a file has been encrypted the 
original file will be overwritten six times using an alternating 0xFF / 0x00 write sequence as specified by the National Security 
Agency. This method assures that the original file will not be readable by sophisticated file resurrection utilities. If this option is
selected it will take slightly longer to encrypt large files due to the extra disk activity required.

Log All Operations to Disk
Check this option to create a log file of all file encryption and decoding activity. The file created will be named CRYPTO.LOG 
and will reside in the same folder as the Crypto program itself. Each time you use Crypto additional file operations will be 
appended to this file. The Crypto log file is a normal ASCII file and can be viewed by any text editor or word processor that 
can display ASCII text.

Duplicate Files
Check this item to skip warnings when adding duplicate files in the list windows. Crypto will cancel the addition of duplicate 
files without prompting you if this option is selected.

Temporary Files
Check this item to skip warnings when selecting files that have a TMP file extension. Crypto will cancel the addition of 
temporary files without prompting you if this option is selected.

File Not Found
Check this item to skip warnings about files listed for encoding or decoding that no longer exist on the disk in the folder 
specified.

Directory Warnings
Check this item to skip warnings when attempting to encrypt or decode folders.

Wrong Format
Check this item to skip warnings when adding file selections that have either already been encrypted or do not need to be 
decoded.

Missing Extensions
Check this item to skip warnings when attempting to add files for encryption or decoding that do not include a file extension.

Invalid Password
Check this item to skip warnings when files listed for decoding do not have the encryption password key you’ve specified.

Locked Files
Check this item to skip warnings when attempting to add files for encryption or decoding that are write-protected on disk.

Sounds with Warning Dialog Boxes



Check this box to play a short beep sound when Crypto displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of Crypto program options. When you press this button the Crypto 
Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Crypto Options property sheet without making any changes. If you have made any changes to 
the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the Crypto Help Window and go directly to the Configuring Crypto topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the Crypto Options 
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Crypto Explorer Setup
Crypto Setup
Select the Help | Setup menu item to display the Crypto Setup property sheet. This window will allow you to integrate Crypto for 
Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS Explorer shortcuts.

Create a Start Menu Item
Check this item to create a Crypto Start Menu entry. The Crypto for Windows 95/NT program will be located in the Software 
by Design folder on the Programs menu. This item will be disabled (grayed) if a Crypto item already exists in the Software by 
Design folder.

Remove this Start Menu Item
Check this item to remove the Crypto entry located in the Software by Design folder on the Programs menu. This item will be 
disabled (grayed) if a Crypto item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a Crypto for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a Crypto desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the Crypto for Windows 95/NT program icon from the Explorer desktop. This item will be disabled 
(grayed) if a Crypto desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run Crypto for Windows 95/NT whenever Microsoft Windows is started. This option creates a 
Crypto program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a Crypto startup item 
already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove Crypto from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a Crypto
startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the Crypto 
Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the Crypto Explorer Setup property sheet without creating or removing any MS Explorer shortcuts.

Help
Press this button to open the Crypto Help window and go directly to the Crypto Explorer Setup topic.



File Menu
File Menu Commands
The File menu provides commands to work with the document files used by Crypto. A short description of each item follows:

Properties
Opens and displays a small window describing the file properties for a selected file. The Alt+Enter shortcut can be used for
this command. You can also double-click your mouse on a file name listed in either of the file windows to quickly display file
properties.

Access
Displays a dialog box that allows you to change the Crypto program access password. This password will be required to 
run the Crypto program itself. The password selected here is not used to encrypt and decode files. If you assign a program 
access password you will be prompted for it the next time you start Crypto. When Crypto for Windows 95/NT is installed for 
the first time no access password is used. To set a password leave the first entry box empty and assign a password in the 
second entry box and then retype it to verify your selection. To remove a password enter the current password in the first 
entry box and leave the remaining two fields blank.

Options
Opens the Crypto Options property sheet and allows you to change Crypto program settings. Use this command to 
configure the Crypto program.

Exit
Closes the Crypto program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Encrypt Menu
Encrypt Menu Commands
The Encrypt menu provides commands used to edit the contents of the Crypto file encryption list. A short description of each 
item follows:

Encrypt Files
Encrypts the files currently displayed in the file encryption list. You will be prompted to assign an encryption password and 
then asked to retype it to verify. The Ctrl+E shortcut can be used for this command. 

Add Files
Opens the MS Windows Explorer File Browser and allows you to select files to be added to the encryption file list. Multiple 
files can be specified by Ctrl-Clicking and Shift-Clicking the mouse on items in the file list.

Tip You can also drag and drop files directly onto the encryption list to quickly add files for encryption.

Remove File
Removes the currently selected file from the encryption list. You will be prompted to confirm file deletions.

Clear Encryption List
Clears the entire file encryption list. You will be prompted to confirm this command before the file encryption list is cleared.

Tip Commonly used Encryption commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Decode Menu
Decode Menu Commands
The Decode menu provides commands used to edit the contents of the Crypto file decoding list. A short description of each item 
follows:

Decode Files
Decodes the files currently displayed in the file decoding list. You will be prompted to enter the encryption password you 
originally assigned to these files when they were encrypted. The Ctrl+D shortcut can be used for this command.

Add Files
Opens the MS Windows Explorer File Browser and allows you to select files to be added to the decoding file list. Multiple 
files can be specified by Ctrl-Clicking and Shift-Clicking the mouse on items in the file list.

Tip You can also drag and drop files directly in the decoding list to quickly add files for decoding.

Remove File
Removes the currently selected file from the decoding list. You will be prompted to confirm file deletions.

Clear Decoding List
Clears the entire file decoding list. You will be prompted to confirm this command before the file decoding list is cleared.

Tip Commonly used Decoding commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change Crypto display options. A short description of each item follows:

Tool Bar
Use this command to turn the toolbar ribbon on and off. If this item is checked the Crypto toolbar ribbon will be displayed 
below the menu bar. To hide the toolbar ribbon uncheck this item. Most commonly used Crypto menu commands have a 
toolbar button. If the toolbar ribbon is turned off you will have to use the normal Crypto menu commands.

Status Region
Use this command to turn the status region on and off. If this item is checked the Crypto status region will be displayed at 
the bottom of the Crypto window. To hide the status region uncheck this item. The status region displays current program 
status and will also display a brief description of each menu command as the mouse is moved through these items.

Font
This item displays the standard MS Windows Font selection dialog. Use this window to select the font face, size and style 
to be used when displaying files in the encryption and decoding lists. The font information you select will be saved and 
used whenever Crypto is launched.

Minimize on Use
Minimizes the Crypto window to a button or icon on the taskbar during file encryption and decoding operations. If this item 
is checked the Crypto window will be minimized during file operations.

Always on Top
Use this command to keep the Crypto window top most on the desktop. When this item is checked the Crypto window will 
float above all other non-topmost windows on the desktop. This item is useful if you normally run Crypto with a small 
window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this command.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with Crypto operations. A short description of each item follows:

Contents
Opens the Crypto Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens Crypto Help and displays the Search window. You can use this window to search for specific Crypto help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the Crypto Shareware Registration Wizard. This wizard allows you to register    Crypto for Windows 95/NT for 
authorized use.

Setup
Displays the Crypto Explorer Setup property sheet. This window provides options to integrate Crypto with the MS Windows 
Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

About Crypto
Displays the Crypto splash box. This window contains program information, the current version of Crypto you are running 
and a program copyright notice. Click the mouse anywhere in this window to close it.

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used Crypto menu commands can also be quickly invoked by pressing a button on the toolbar ribbon displayed 
at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they duplicate. 
The Toolbar selection on the View menu must be selected to display the toolbar ribbon.

Encrypt – Encrypt files

Add – Add files to the encryption list

Remove – Remove files from the encryption list

Decode – Decode files

Add – Add files to the decoding list

Remove – Remove files from the decoding list

Properties - Show file properties

Topmost – Make the Crypto window topmost

Font – Select a font for file lists

Options - Open the Crypto Options dialog

Help - Open this Help file

About - Show the Crypto splash box

Tip A small popup tip window will appear when the mouse pointer is placed over a button. A short description of what each 
button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke Crypto menu commands without first displaying the menu and then selecting an item 
from it. The most commonly used Crypto commands can be invoked using the following shortcut keys.

Alt+Enter Display file properties
Ctrl+Q Exit Crypto, and return to the desktop

Ctrl+D Decode the current file list
Ctrl+E Encrypt the current file list

Ctrl+T Make Crypto topmost
F1 Display this Help file

Tip    The Ins, Del and Clear keys can also be used to quickly add and remove files from the currently selected file list window.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in Crypto for Windows 95/NT please feel free to contact me on CompuServe.

Gregory Braun
CompuServe: 71613,2175
Email: 71613.2175@compuserve.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Release History
Crypto for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Fixed several minor bugs. 

v2.3 Added MS Windows 95/NT Help file. 

v2.4 Replaced the CRYPTO.INI file with MS Windows 95/NT System Registry entries. Added the Crypto Explorer Setup 
dialog box    Fixed several minor bugs.

v2.5 Added a tool bar ribbon and ListView file windows.

v2.6 Added missing string resources to the executable.

v2.7 Converted the Crypto Options dialog box to a three-tab property sheet. Fixed a bug that prevented proper window 
repositioning when the MS Explorer Taskbar was placed along the left edge or at the top of the desktop and the Auto 
Hide option was active.

v2.8 Fixed several minor bugs.

v2.9 Fixed a bug that prevented a large number of files to be selected when using the standard MS Windows File Browser 
dialog box. Crypto now behaves like a true Taskbar Tray application when the Place Icon in the Taskbar Tray option is 
selected. Several other minor bugs have been fixed.

v3.0 Added the Shareware Registration Wizard. Fixed several minor bugs.

v3.1 Added a setting to optionally remove the original file after conversion operations. Improved the encryption algorithm used
to encode files. Fixed several minor bugs.

Last Update    April 6th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



System Registry
Crypto for Windows 95/NT System Registry Key
Crypto for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while Crypto is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. Crypto automatically updates registry entries when it exits. If 
you wish to edit these settings make sure Crypto is not running while you edit them. If Crypto is currently running your editing 
changes will be overwritten when Crypto exits.

Crypto for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
Crypto for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. Crypto will automatically maintain these settings for you. If you do edit
these, you do so at your own risk.



Removing Crypto
Removing Crypto for Windows 95/NT
If you find that Crypto for Windows 95/NT does not meet your data encryption needs you can remove it from your computer 
system by simply deleting the following files from your hard drive.

All of these files will be located in the folder that you originally installed Crypto in.

The default location for all Crypto for Windows 95/NT program files is the C:\Program Files\Software by Design folder. Unless 
you specified a different folder when you ran SETUP.EXE you will find the Crypto files here.

Crypto.exe Crypto application program.
Crypto.cnt Crypto Help Topics File
Crypto.hlp Crypto Help File

If you have opened and used the Crypto for Windows 95/NT Help files your system may contain the following two (2) files. These
files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

Crypto.gid MS Windows Help settings file. This file contains the Crypto Help window size and desktop location as well 
as any bookmarks you may have created.

Crypto.fts MS Windows Help word database. This file is created when you build a custom word list for Crypto Help 
files. This file is used to search for words and phrases in the Crypto Help files.

Crypto for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed Crypto from your computer system.

Note If you have installed Crypto shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the Crypto files mentioned above.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"Crypto for Windows 95/NT v3.1"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering Crypto for Windows 95/NT
Registering Crypto
Crypto for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use Crypto for Windows 95/NT you are required to register it. If after evaluating Crypto for 30 days you decide not to 
register it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Crypto for Windows 95/NT by mailing the Order Form provided with this software. When you register Crypto for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when Crypto for Windows 95/NT is first launched.

To register your copy of Crypto for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered Crypto for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered Crypto for Windows 95/NT. If you did not specify
an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased Crypto for Windows 95/NT. Refer to the notification 
letter that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered Crypto for Windows 95/NT. When you successfully register your 
copy of Crypto this box will automatically be unchecked for you. If you wish to see the splash box when Crypto is launched 
return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete Crypto for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the Crypto Help window and go directly to the Registering Crypto topic.



Purchasing Information
Purchasing Information
Crypto for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days if you 
continue to use Crypto for Windows 95/NT you are required to register it. If after evaluating Crypto for 30 days you decide not to 
purchase it you are required to remove it from your computer.

Registration entitles you to unlimited free updates and telephone support.

You can register Crypto for Windows 95/NT by mailing the Order Form provided with this software. When you register Crypto for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

The software you are currently using is a fully functioning program. There are no time limitations built into the software to restrict 
its continued use and no program features have been disabled. As a registered user you will however be able to disable the 
initial splash box that appears when Crypto for Windows 95/NT is first launched.

Single User Licensing
Individual users can register Crypto for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to you 
please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of Crypto directly from the Software Design web site on the Internet. Print the Crypto for 
Windows 95/NT Order Form and mail it with your check to become a registered user of Crypto for Windows 95/NT.

Site Licensing
Crypto for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use 
Crypto on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of Crypto directly from 
the Software Design web site on the Internet. Print the Crypto for Windows 95/NT Order Form and mail it with your check to 
become a registered user of Crypto for Windows 95/NT.

Corporate Licensing
Crypto for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and 
use Crypto on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk 
and entitles you to unlimited free updates and telephone support. You can always download the latest release of Crypto directly 
from the Software Design web site on the Internet. Print the Crypto for Windows 95/NT Order Form and mail it with your check to
become a registered user of Crypto for Windows 95/NT.



Crypto for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of Crypto for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of Crypto for Windows 95/NT may either be used by a single person who uses the software personally on
one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of Crypto for Windows 95/NT through a network, 
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of Crypto for Windows 95/NT through a 
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of Crypto for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.




